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Next Meeting 
Wednesday 2nd February 2011 

AGM 
 

All Positions Vacant 
 

SUBSCRIPTIONS DUE  
Dennis will demonstrate the insides 

of a Laptop 
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OPEN Committee 2009/10  
Chairperson OPEN: Robert Tierney. Chair all meetings of OPEN and en-
sure that they run smoothly 
Vice Chairperson OPEN: June Hazzlewood.  Chair meeting when the 
Chairperson is unavailable. 
Secretary: Margaret Carrington  Handles all incoming and outgoing 
communications Responsible for the documentation and distribution 
of all meeting minutes 

Assistant Secretary: - open -.  Help the Secretary where necessary 

Treasurer: Dennis Murray. Responsible for all monies and banking 

Assistant Treasurer: . Help the Treasurer where necessary. 

Publicity Officer: Karia Wicks. Responsible for all advertising 
OPEN Co-ordinator: Robert Tierney. Responsible for the smooth run-
ning of Centre on a daily basis 
Membership Co-ordinator: Karia Wicks. 
Keep Membership database up to date. 

Beginners Project Co-ordinator: 
El- eanor Horder. 
Tu- tor Co-ordinator: Robert Tierney. Keep regular contact 

with Tutors to bring ideas and concerns to meetings 
Assistant Tutor Co-ordinators: Eleanor Horder and Janet Headlam. 
Newsletter Editors Assistant: Dennis Murray. Collates and produces the 
OPEN Newsletter for inclusion in LCG monthly 'Newstream' 
Technical Co-ordinators: Dennis Murray (PC's) and Joel Harbottle (Mac).  
Responsible for the maintenance and repairs to all computer equip-
ment 
Co-ordinator of "VICTOR": Robert Tieney. 
Webmaster/Content: Tom Olsen.  OPEN Committee: Iris Meek, Harvey 
Tavener, Robin Walker, Barry Symons, Laraine Rist. 

LCG Committee 2009/10 
President: Iris Meek 

Vice President: Janet Headlam 

Minutes Secretary: Larraine Rist 

Treasurer: Dennis Murray 

Ass.  Treasurers:  

MAC Librarians: Joel Harbottle 

PC Librarian: Julie Hjort 

Ass.  PC Librarian: Judy Hall 

Newstream Editor: Ron Baker  

Publicity Officer: Karia Wicks 

Ass.  Publicity Officer: - open - 

OPEN Co-ordinator: Robert Tier-
ney 

Webmaster/Content: Tom Olsen  

Auditor: Ron Baker 

"VICTOR" Liason: Robert Tierney 

General Committee: Mike Armes, Sue Armes, Glenn Gilpin, 
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OPEN NEWSLETTER – Jan—Feb 2011 

 

PSP X1 
Advanced Graphics 

 
February 23   1 pm to 3 pm 

 

November O.P.E.N shared a display table with 
“Another Computer Store “ at the A.I.R (Australian 
Independent Retirees) expo. 
 
During the year I have been networking with other 
organisations that are involved with seniors through 
a forum that Centrelink holds quarterly. We have had 
three new volunteers come through Centrelink . 

 
The Christmas lunch was held at the Sunnyhill Hotel, 
it was a wonderful meal, but due to an unfortunate 
mix-up in seating arrangements that was human 
error not the hotels fault we were given a discount on 
the meal and free drinks. 65 people attended and a 
good time was had by all. 

 
At the beginning of 2011 we have close on 100 
financial members with a lot of people still to rejoin 
due to being away. 
 
Olearn has been as popular as ever big thanks to 
Eleanor for all her hard work in keeping all the 
different versions up to date. In 2010 we had 70 
people do the Olearn course and we had 20 people 
who finished the course and wanted and received a 
certificate. 
 
Rob Tierney 

 
OPEN Coordinator 
 

   

Coordinators Report for 2010. 
 
It was another busy year at O.P.E.N . A major milestone 
was reached in the life of O.P.E.N we welcomed our 
1000th member. 
 
We sadly lost two of our long term members  Alan Jones, 
Len Reynolds. 
 
In March O.P.E.N had a display at the Expo for Seniors 
which was held at Launceston’s Bowls Club. 
 
In June V.I.C.T.O.R sponsored Australia’s Biggest morning 
tea for Cancer Council  
 
O.P.E.N registered with Volunteer Connect a website 
hosted by Volunteer Tasmania to attract new volunteers , 
we had several expressions of interest during the year 
from the website. 
 
June Hazzlewood through national Council of women, 
received a $2000,00 grant toward volunteer travelling 
expenses. 
 
Seniors week in October this year we had tutors speaking 
on a variety of subjects instead of having normal classes 
we had a great response from the public, only drawback 
was our  
Saturday forum landed on grand final day. O.P.E.N 
received a $2,000 grant for Seniors Week which covered 
catering, advertising etc. 
 

 

WHAT’s INSIDE YOUR  
NOTEBOOK COMPUTER? 

 
Dennis Murray has offered to bring 
along an old laptop to show those 

attending the LCG AGM Wednesday 
February 2 what is inside… 

 
It will make us all understand the  

intricacies of dismantling note-
books for repair work. 
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Web sites for Cooks  
& Entertainers: 
 
www.taste.com.au 
 
www.cuisine.com.au 
 
http://Allrecipes.com 
 
http://recipefinder.ninemsm.com.au 
 
www.chefspencil.com 
 
www.sbs.com.au/food 
 
http://entertaining.about.com 
 
http://startcooking.com 
 
www.epicurious.com/articlesguides/e
ntertaining 

OPEN NEWSLETTER – Jan—Feb 2011 

 
Anyone who has a substantial amount  
of data stored  on their flash drive (or 
drives) MUST make sure that that 
contents are copied to a folder on 
their hard drives on a regular basis. 
      Those of us who use their flash 
drives for moving data between home  
and the club, or anyone who has 
programs and utilities on their flash 
drive would probably be in a real 
mess if a flash drive became 
damaged or was lost. 

Dennis 
I will take this opportunity to wish Judy much 
better health in 2011 than has been her lot 

for a large part of 2010. 

LEVEL 2 & 3 GRAPHICS  
With Paint Shop Pro 7 and 8 

February 16 — 1 pm—3 pm 
 

Advanced Graphics for students who have al-
ready completed Basic Graphics classes.  
It involves more advanced features of the Paint 
Shop Pro graphics programs.  
 

Numbers are limited to 8 people. Please check 
the notice-board or contact the club for details. 

 
FAMILY HISTORY ON-LINE 

 
     February 9   - 1pm—3pm 

February 23  – 10—noon 
            March 9  - 1 pm—3 pm 

 

Judy, Margaret and Sandra will guide you through the  
processes used to research your ancestr  
Contact the club for more information 

 

Classes are limited to 8 people. 

. 

GRAPHICS  
Please check the Notices  at the club to find out if 
there are places available. 
 

New classes beginning in February 
Check to Register on form near desk. 

 
February 2  ( T B A ) 10—noon 
February 9 Basics—10—noon 

 

On Line 
Shopping 

February 16 
10—noon 

Best wishes to Judy Hall. We hope to see her back  
In good health at classes in 2011,  fully mended and 
ready to take charge of the family history and graphics 
classes again. 
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Monday 10 am –12  General &  
Beginners 

 1 pm – 3 pm Beginners & PC 
Support 

Tuesday 10 am –12  P C Support & Begin-
ners + Mac  

 1 pm – 3 pm  As above 

 7 pm—9 pm PC Support (Night 
Class) 

Wednesday 10 am—noon Special sessions or 
Meetings 

 1.pm—3 pm As for mornings  
(see rosters) 

 3.30—5.30 P C Support 

Thursday 10 am –12  
 

General &  
Beginners  

 1 pm – 3 pm General &  
Beginners  

 3.30—5.30 Absolute Beginners 

Friday 10 am –12  General &  

Beginners 

 1 pm—3 pm Beginners 

OPEN Session Times 
At Studioworks, 1 Pipeworks Rd, L’ton 

 

Standard Sessions $5.00  
SPECIAL  WEDNESDAY SESSIONS 

Please register on the sheets – numbers may be limited  
Date Time Topic Details 
February 2 10 am—12 noon T B A Watch the Notice Board for information. 

 1pm OPEN AGM 

February 9 10 am—noon Basic Graphics Judy, Karia and team 

 1 pm—3 pm Family History On line With Judy and the team 

February 16 10—noon 
  

On line Shopping With Judy Hall 

 1 pm—3 pm Level 2 –3 Graphics Judy, Eleanor, Karia, Laraine 

February 23 10—noon Family History On line Tracing your history using the internet 

 1 pm—3 pm PSP X1 Advanced Graphics with Judy and Eleanor 

March 2                
10—noon               

March 2                
10—noon               

Graphics Workshop Revisit what you have learned so far. 

 

 

 

 1 pm OPEN Meeting 

OPEN NEWSLETTER – Jan—Feb 2011 

Club helpline   ……………….   Victor Phone No. 0408 174235 
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OPEN NEWSLETTER – Jan—FEB 2011 _ 
 

 
Many thanks 
to Karia’s 
present employer  
Money 3 for his kind donation of the much 
needed paper shredder. 
It will come in very handy at our club. 
Also thanks to Barry Symons for collecting 
it from the George St store. 

LCG Committee 2010 
 

President: Barry Symons 
 
Vice President: Janet Headlam 
 
Minutes Secretary: Laraine Rist 
 
Treasurer: Iris Meek 
 
Ass. Treasurer: Karia Wicks  
 
MAC Librarians: Ivan Turmine 
 
PC Librarian: Julie Hjort 
 
Newstream Editor: Ron Baker 
 
Publicity Officer: Iris Meek 
 
Ass. Publicity Officer: - open - 
 
OPEN Co-ordinator: Robert Tierney 
 
Webmaster/Content: Tom Olsen 
 
Auditor: Ron Baker 
 
"VICTOR" Co-Ordinator: Robert Tierney 
 
General Committee: Judy Hall, Glenn Gilpin, Reinhard 
von Samorzewski 

   

 
VENUE TELEPHONE NUMBER 

 
 

The club telephone is  
available 

 during class hours. 
 

OPEN Committee 2010 
Chairperson  Judy Hall 
Co-ordinator  Rob Tierney 
Vice Chairperson  June  Hazzle-
wood 
Minute Secretary  Margaret Car-
rington 
O Learn Co-ordinator Eleanor Horder 
Turtor Co-ordinator E Horder 
Assist. Tutor Co-ord. David Renton 
Assist Treas.  Karia Wicks 
Membership Co-ord. K Wicks 
Newsletter Editor           Iris Meek 

 The positions in the left hand panels will all be-
come vacant February 2. 
 
Some of our members have kindly put their 
names forward for re-election or for the first time. 
 
This shows an interest in the club which is itself 
unique in what it offers. 
 
Without committees we can not operate. 
 
Many thanks to all the tutors who have worked 
so hard during the year, also to those who pro-
jected workshops for students. 
 
The club sent expressions of sympathy to Betty 
Tatlock after the death of her husband Peter. We 
hope Betty will feel up to returning to OPEN in 
the near future. 
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PDF EXPLAINED 
 

One of the problems of having been  involved with 
computers for nearly 30 years is that one can be prone to 
assumptions—of believing that what I consider to be 
common knowledge is well-known to everybody who uses 
computers. 
 

Terms such as PDF (for Portable Document Format) roll 
easily off our tongues  and we assume that everybody 
understands  the ’jargon’.   
 

Basically a PDF is a file that can be read on most computers 
regardless of whether it has  a Windows, Macintosh, Linux or 
any other operating system.  
 

For LCG-OPEN club members your most frequent  encounter 
with a PDF might be  when you read our monthly newsletter, 
“Newstream”. To read a PDF file you need to have  some 
version of Adobe Acrobat Reader installed on your computer, 
and when you double-click the newsletter file Adobe Reader 
will automatically start up and you will be able to read or 
print out the newsletter at your leisure. 
 

Let us now go back a few steps and consider why we make 
“Newstream” available as a PDF file and the process involved 
in creating a PDF. 
 

“Newstream” (including the OPEN newsletter) is created 
using Microsoft Publisher. If our editor was to make it 
available as  a ‘PUB’ file (more jargon!) then you would need 
to have the applicable version of  Publisher on your 
computer, and that might cost you quite a few dollars e.g. 
Publisher 2010 can cost about $170-$200. 
 
So to allow you to save that money our editor converts the 
newsletter to PDF with a special program.  There are many 
of these available, some which are free and some which are 
commercial products. 

PDF EXPLAINED (continued) 
Some PDF creation programs install an extra ‘virtual’’ 
printer on your computer. However the output from this 
printer doesn't result in one or more pieces of paper 
arriving on your desk or computer table . What you get 
instead is a PDF file that is written to your hard disk.  
 

In most instances that PDF file will include all the 
formatting, pictures and special effects that would be 
available if you had Microsoft Publisher on your 
computer. If you then wish to print it out you would 
open up the PDF with Adobe Reader, click the Print icon 
and select your ‘physical’ printer—at OPEN this could be 
the  Canon IP4300 or the HP Laser Jet 2600. 
 

The freeware Open Office suite of programs has the 
ability to create PDFs of Word-processing and 
Spreadsheet documents by enabling you to export them 
as PDF files rather than by installing a virtual printer. 
 
Apart from our monthly newsletter you may also find 
that instruction manuals for computer software and 
hardware are produced as PDFs. Good reasons for doing 
this are that manufacturers don’t have to produce 
different versions of their manuals, nor do they want 
computer users to be able to interfere with their 
manuals, so they produce them in a format that can’t be 
edited. Unless, of course, you want to spend several 
hundred dollars to purchase the Professional version of 
Adobe Acrobat 
 
If anyone would like to learn more about PDF documents 
we may be able to conduct a special session at an OPEN 
or LCG meeting during the year. 
 

Dennis Murray 

SNIPPETS 
 

If you are a user of Spybot Search and Destroy you 
might have noticed that the program seems to have been 
streamlined lately.  
 
Instead of checking for about 1.3 million potential nasties 
the number has been reduced to around 780,000. I’m 
assuming that better programming has led to the 
reduction. 
 
How many Trojans? A club member rang me recently 
quite concerned that ‘something’ was reporting that the 
computer was infected with more than 300 Trojans, and of 
course, that certain ’something’ was offering to provide a 
solution provided that the member parted company with 
some cash. My thoughts? 
 

“SCAM”  
A by-product of this encounter with the forces of 
computer evil was that the member could not turn off the 
offending web-page. It didn’t matter whether he clicked 
‘Cancel’ or the ‘x’ in the top right-hand corner it would not 
go away. 
 

Solution? Just consider that ‘my web-page has frozen’ 
and use the good old CTRL + ALT + DEL combination on 
your keyboard to open up the Task Manager, go to the 
Applications tab and check which programs are running.  
 

In this case the program was shown as a suspicious IP 
address so I suggested that our member should select the 
program, then click the ‘End Task’ button to close the 
obstinate web-page. I think that did the trick! 
 
    Dennis 
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LAUNCESTON COMPUTER GROUP, Inc. 
Meeting held at 1/1 Pipeworks Road 

Meeting Minutes:  
Date:  Wednesday 1st December 2010  

Meeting:  Opened at 7.30 pm 
Present:  Barry Symons, Janet Headlam, Iris Meek, Ted Bramich, Harvey 
Tavener, Glenn Gilpin, Ivan Turmine, Dennis Murray, Eleanor Horder, 
Laraine Rist. 
 
Apologies:  Reinhard  vonSamorzewski, Tom Olsen, June & Bert 
Hazzlewood, Julie Hjort, Judy Hall, Ron Baker. 
 
Minutes:The minutes of the meeting held November 3rd November were 
read and confirmed: Iris Meek and seconded: Harvey Tavener. Car. 
 
Business arising from the Minutes:  Market – As Glenn did not 
receive a reply from the Show Society, it was decided to leave the next stall 
until after the AGM in February. 
  ASCCA Volunteer Insurance – The new quote to cover up to 85 
year olds is $393 p.a. The contents insurance costs have risen. 
  Computer 14 – A new mother board and processor have been 
ordered. 
  Projector – is to be left in abeyance until Judy is available 
  Window blinds or covers – discussed at Open and is to be left in 
abeyance 
Correspondence: 
An invitation addressed to Launceston Computer Group inviting 2 
members to attend Volunteering Tasmania evening on Friday.   
Financial Report:  as attached  Moved: Iris Meek  Seconded:  Janet 
Headlam. Filed with minutes. 

 
General Business: 
  Cleaner – From the Open meeting, it was decided that the cleaner is 
to have a job description.  Any suggestions from the members may be put 
in writing into Rob’s pigeon hole. 
  A new Tutor is to be assessed by the interviewing committee. 
  Tony Garret, the newest tutor is fitting in very well and is extremely 
helpful and well liked. 
  Laraine to send a get well card to Judy. 
  At the Open meeting it was suggested that Eleanor become a Liason 
Officer between LCG and OPEN 
  It was suggested that Tutor Meetings be held more frequently to 
acquaint tutors with each other and maybe some training of some 
description be available at these meetings.  The Volunteers Information 
sheet is out of date and needs to be changed. It was further suggested that 
the Volunteer Wallets be re-introduced. 
 
  Geoff Daw from Another Computer Store would like to be 
approached when we are after quotes for new equipment. Quotes are to be 
tabled at a meeting before any purchases are made 
 
 Meeting closed: at 7:50 pm and was followed by a delicious pizza supper 
and social chat 
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10 great 'Do these first' tweaks for Windows 7  
By Fred Langa  
 
It's that time of year when many PC users are buying new machines and — 
ready or not — making the  
ª Get off on the right foot: save time, trouble, and frustration by performing these 

10 simple Win7 tweaks. 
 
It's happened to me, and I'll bet it's happened to you: weeks or months into 
using a new OS, you find yourself saying, "Geez, I wish I'd known that at the 
beginning!" 
 
I've worked with Win7 for a year now, and in that time I've learned more than a 
few tricks and tweaks for setting up and getting started with this new OS. Here 
are the 10 best that can help you improve Windows 7's stability and 
recoverability, make the OS work faster, increase its ease of use, and 
maximize your on-screen real estate. 
 
Feel free to pick and choose the ones that appeal to you. Even if you don't use 
any, I'll bet you'll learn a few things about Windows 7 that you didn't know 
before! 
 
Let's get started. The first four steps help you prepare for unexpected system 
failures and security breaches:  
 
Build a rock-solid safety net for Win7  
 
► Create a system repair disc right away: When you're starting out with a 
new OS or a new PC, things sometimes go awry. That's why it's always smart 
to make an emergency boot disk before you do anything else. 
 
An emergency boot disk lets you start your PC and perform repairs, even if the 
hard drive is trashed or the operating system is otherwise unbootable. Having 
an emergency boot disk on hand can be the difference between successfully 
completing a quick do-it-yourself repair and having to send your system off to 
the repair shop! 
 
Windows 7's built-in system repair disc tool creates emergency boot disks, 
and the whole process takes just a couple of minutes. Click the Win7 Start orb 

and type the phrase system repair into the search text box. At the top of the 
search results you'll see Create a System Repair Disc (under Programs). 
Click it and follow the prompts. (See Figure 1.) That's all it takes! 
 
  

Figure 1. Windows 7's built-in "System Repair Disc" feature makes it 
incredibly easy to build a bulletproof emergency boot CD or DVD. 
 
Put the new disk in a place that's safe but where you can grab it quickly if it's 
ever needed. 
 
Bonus info: Lincoln Spector's July 8, 2010, Insider Tricks column shows how 
to create a flash-drive version of the emergency boot disk! 
 
► Use the new "Create a system image" tool: Windows 7 is the first 
Windows to include an app that makes a complete image backup of your 
setup. Unlike a conventional file-by-file backup, an image backup is a 
compressed, byte-for-byte clone of your entire hard drive's contents. 
 
Restoring a saved image puts your hard drive back into exactly the same 
state as when you made the image. It's the gold standard of backups and is 
the only way to absolutely, positively roll back a system to a prior state. 
 
Win7 makes image backups a snap. Open the Control Panel and, under 
System and Security, click Back up your computer. In the left pane, select 

(Continued on page 10) 
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Figure 2. Microsoft Security Essentials is smaller and faster than most 
commercial security suites. It's also free. 
 
Make Windows 7 run faster, work better  
 
► Give Internet Explorer 8 better speed: As the gateway to the Internet, 
our browser might well be our most important app. Win7 ships with Internet 
Explorer 8 and by default is preconfigured with many nonessential add-ons 
and ancillary features that could slow it down. (These default settings might 
be one of the reasons why IE8 is slower than Firefox and Chrome in most 
performance tests.) 
 
I recommend turning most default options off, and here's how: 
When you first launch IE8, you'll be asked to choose your settings. Select 
Choose custom settings. 

ª When asked whether you want to turn on IE8's suggested sites, select No, 
don't turn on. 

ª When asked to choose a default search provider, select Show me a 
webpage after setup to choose more search providers. Making a manual 
selection helps ensure that you bypass any associated initial default settings. I 
prefer Google over the default Bing anyway, but you can choose Bing or any 
other provider you wish. The point here is to avoid accepting the initial, built-in 
defaults. 

ª When asked to download search provider updates, select No. 

(Continued on page 11) 

Create system image and follow the steps. 
 
Should you ever need to restore a system image and you'd like some pointers, 
see the MS article, "Restore your computer from a system image backup." 
 
► Fully automate your routine backups: Image backups are great for 
rolling back an entire system. But file-by-file backups are best for restoring one 
or more individual documents, photos, or other files you accidentally delete or 
destructively alter. 
 
Open the Control Panel and click System and Security, then Backup and 
Restore. In the right pane, select Set up backup and follow the steps. 
 
At the end of the process, before clicking Save settings and run backup, you 
can change your backup schedule by clicking Change schedule. (Find more 
info on backup and restore in an MS tutorial.) 
 
Couple Win7 backups with the OS's built-in Restore previous version 
feature, and you may never lose a file again — ever! (See Microsoft's FAQ for 
the limitations and steps required for recovering previous versions.) 
 
► Install Microsoft Security Essentials: Most commercial security suites 
are overblown and tend to bog down the systems on which they're installed. 
MSE (download site) is small, fast, and free — definitely worth trying in place 
of competing suites. (See Figure 2.) 
 
For a complete review of MSE, see my September 16 Langalist Plus article, 
"Security Essentials test drive — month 6," in the paid section of the 
newsletter. 
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ª When offered a choice of accelerators, select Turn off all Accelerators that 
are included with Internet Explorer, as shown in Figure 3. (They don't really 
accelerate anything.)  Figure 3. IE8 performs faster if you turn off the 

default add-ons and ancillary features that can slow it down. 
ª When asked whether you want to use Compatibility View updates, answer 

Yes; compatibility view is useful on older and nonstandard websites, and 
having it enabled doesn't seem to slow down normal browsing. 

ª At some later point, IE8 will ask whether you want to turn on autocomplete. 
Select Yes; it is a time saver. 
 
► Resize the recycle bin downward: Windows 7 has finally reined in the 
formerly voracious appetites of the caches used by Internet Explorer and 
System Restore. But the recycle bin can still be ridiculously large when 
Windows is installed on a large hard drive. A needlessly large bin size creates 
unnecessary Windows housekeeping overhead and wastes disk space. 
 
Right-click the recycle bin, select Properties, and set a more reasonable 
Custom size — typically 250MB to 500MB. 
 
► Improve Explorer's folder options: By default, Windows tries to keep 
novices out of trouble by hiding some system-related settings and features. 

(Continued from page 10) For example, Windows normally hides system-level folders and files. But most 
experienced Windows users find these safety features annoying. So when 
setting up a new system (or upgrading an older one), I make four changes to 
the default folder view options. 
Click the Start orb, Control Panel, Appearance and Personalization, then 
Folder Options. 

ª Check (enable) two items that are normally unchecked: Always show menus 
and Show hidden files, folders, and drives. The latter is under the Hidden 
files and folders subsection. 

ª Uncheck (disable) two items that are checked by default: Hide extensions 
for known file types and Hide protected operating system files, as shown 

(Continued on page 12) 
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in Figure 4The latter will generate an "Are you sure?" warning.)  . (Figure 4. 

Take the training wheels off Windows' folder views by changing the 
Folder Options settings. 

Click the Apply to Folders button at the top of the dialog, and these changes will 
propagate throughout your system. (Note: When you unhide system files, a 
desktop.ini may appear on your desktop. It's fine to delete this file, if you wish.) 

 
Organize your new Windows 7 desktop  
 
► Put frequently accessed items on the desktop: Although I don't like 
needless clutter, I appreciate having frequently used features and functions — 
such as shortcuts to Computer, Network, Control Panel, and the default User's 
files — instantly available. 
 
Right-click on any empty spot on the Desktop and select Personalize. On the 
upper-right side of the pop-up setting box, click Change desktop icons. In the 
ensuing dialog box, check whatever frequently accessed items you wish. (See 
Figure 5.) I check them all. 
 
  

Figure 5. It's easy 
to place frequently 
accessed system 
shortcuts on the 
desktop for quick 
access. 
 
► Ultra-customize 
your desktop icon 
size: You can make 
your desktop icons 
almost any size you 
want with your 
mouse's scroll 
wheel. First, make 
sure the desktop 
has the focus (i.e., 
no other window is 
selected); then 
press and hold the 
Ctrl key while 
rolling the mouse 
wheel up or down. 
The desktop icons 
will step through 
many sizes, from 
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AU T OF I L L  W I TH  RA ND OM  
NU M B ER S  
Excel includes a feature that allows you to automatically fill a range of cells with 
information you have placed in just a few cells. For instance, you could enter the 
value 1 in a cell, and then 2 in the cell just beneath it. If you then select the two 
cells and drag the small black handle at the bottom right corner of the selection, 
you can fill any number of cells with incrementing numbers. This AutoFill feature 
sure beats having to type in all the values! 

You may wonder if there is a similar way to use the AutoFill feature to place 
random numbers in a range. Unfortunately, the AutoFill feature was never meant 
for random numbers. Why? Because AutoFill uses predictive calculations to 
determine what to enter into a range of cells. For example, if you entered 1 into 
one cell and 5 into the next, highlighted the cells and then used AutoFill, the next 
number entered in the cell below would be 9 because Excel can deduce that the 
increment is 4. It is a constant increment that can be predicted. 

Random numbers on the other hand are, well, random. By nature they cannot be 
predicted, else they wouldn't be random. Therefore the predictive nature of 
AutoFill cannot be applied to random numbers. 

However, there are ways around this. One is to simply use the various formulas 
(using RAND and RANDBETWEEN) to generate random numbers. These 
formulas can quickly and easily be copied over a range of cells, using a variety of 
copying techniques. 

Another approach is to use a feature of the Analysis ToolPak which makes putting 
random numbers into a range of cells pretty easy. Just follow these steps: 

1. Choose Data Analysis from the Tools menu. If you are using Word 
2007 or Word 2010, you display the Data tab of the ribbon and then 
click Data Analysis in the Analysis group. (If you don’t see the Data 
Analysis option on the Tools menu or, in Word 2007 or Word 2010, 
you don’t see the Analysis group on the Data tab of the ribbon, it 

(Continued on page 14) 

IN S E RT IN G  T H E  TE M PL AT E  NA M E  
I N  YOU R  DO C UM E N T  
Every Word document has a template attached to it. Depending on your version of 
Word, this template defines things such as your menus, toolbars, macros, and 
styles (among other things). If you do not explicitly attach a template, then Word 
uses the Normal template. 

The name of the template file attached to your document can be inserted into your 
document and updated automatically. To do this, follow these steps: 

1. Position the insertion point where you want the template file name to 
appear. 

2. Display the Field dialog box. (In Word 2007 or Word 2010 display the 
Insert tab of the ribbon and then choose Quick Parts | Fields from the 
Text group. If you are using an older version of Word, choose Field from 
the Insert menu.) 

 

The Field dialog box. 

3. In the Categories list, choose Document Information. 
4. In the Field Names list choose Template. 
5. Click on OK to close the dialog box and insert your field. 

Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands of 
free Microsoft Word tips can be found online at http://word.tips.net. 
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means that you don’t have the Analysis ToolPak enabled.) Excel 
displays the Data Analysis dialog box. 

 
 
 
 

 
 
 
 
 
 

The Data Analysis dialog box. 

2. In the list of functions in the dialog box, choose Random Number 
Generation. 

3. Click on OK. Excel displays the Random Number Generation 
dialog box 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Random Number Generation dialog box 
 

 
4. Using the controls in the dialog box, indicate the parameters you 
want used in generating a range of random numbers. (Make sure that 
you specify a range of cells in the Output Options area of the dialog 

box.) 
5. Click on OK. 

Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands 
of free Microsoft Excel tips can be found online at http://excel.tips.net. 
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UN D ER S TAN D IN G  A ND  
CR E AT I NG  L I S TS  
There are two types of lists commonly used in printed material. The first is 
a bulleted list, and the second is a numbered list. A bulleted list is a nothing 
but a list of individual items with a symbol to the left side of the first line 
of each item in the list. For example, the following is a bulleted list: 

This is the first item in the list. 
This is the second item in the list. There is more than one line in this 

item. Notice that the extra lines are aligned with the line above, 
not with the bullet or the text margin. 

This is the third item in the list. 
This is the fourth item in the list. 

In the case of this bulleted list, the symbol used as the "bullet" is a small 
dot. A numbered list is a little bit different. It consists of a series of items, 
each with a sequential number in front of it. Numbered lists are used 
extensively in “how to” writing to describe a sequence of steps to be 
followed. 

This usage points out the primary way you can decide which type of list to 
use. If you have a sequence of steps, which must be followed in order, then 
you should use a numbered list. If you have a group of items to which you 
want special treatment given, but they don't represent a series that must be 
followed in sequence, then you should use a bulleted list. 

Word allows you to quickly and easily create lists. To do so, follow these 
steps: 

1. Type your list, only pressing ENTER at the end of each item in the 
list. If an item runs more than one line, do not press ENTER at the 
end of each line. 

2. Select all the items in the list. 
3. Click on the Bullets list tool to create the bulleted list or the 

Numbering tool to create a numbered list. (If you are using Word 
2007 or Word 2010, these tools are located on the Home tab of the 
ribbon, in the Paragraph group. In older versions of Word they are 
located on the Formatting toolbar.) 

Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by 
permission. Thousands of free Microsoft Word tips can be found 
online at http://word.tips.net. 
U S I N G  T H E  C ON C AT ENAT E  
W O R K S H E E T  F U N C T I O N  
Excel provides a function called CONCATENATE which can be used to 
combine the contents of several cells, or even to combine cell contents with 
other text. For instance, let’s say you wanted to add together the contents of 
cells A3 and B3, separate them by a space, and have the result appear in 
cell C3. All you need to do is put the following formula in cell C3: 

Primarily, the CONCATENATE function is used for compatibility with 
other spreadsheet programs. You can just as easily use the ampersand (&) 
operator to combine text values using a formula. For instance, the following 
is equivalent to the example of CONCATENATE shown above: 

Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by 
permission. Thousands of free Microsoft Excel tips can be found 
online at http://excel.tips.net. 
 

=CONCATENATE(A3," ",B3) 

=A3 & " " & B3 
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Two great security tools get free updates  
 
 By Fred Langa  

 
Two outstanding security apps, Microsoft Secu-
rity Essentials 2.0 and Secunia Personal Soft-
ware Inspector 2.0, are now available. 
 
The original versions of these programs were great, 

but the new versions are even better; they're must-have software — 
and they're still free! 
 
Beefing up Microsoft Security Essentials  
 
In December, after a four-month beta test, Microsoft quietly released 
a major revision of its impressive and free Security Essentials anti-
malware tool. The new version is slowly being rolled out via Win-
dows Update, but you can — and I think you should — grab it right 
away.  
 
MSE 2.0 is a nearly total rewrite of Microsoft's security tool. Although 
there are some visual changes in the software (more on that in a 
moment), the most significant enhancements are under the covers. 
 
The most important change: MSE 2.0 now uses heuristic malware 
detection in addition to the same definitions-based malware detec-
tion methods employed by MSE 1.0. Heuristic technology has been 
around for years and is designed to detect new malware based on 
behavior, thus protecting you against threats that aren't yet in the 
definitions database. MSE2 calls this feature behavior monitoring. 
(See Figure 1.) 
 

  
Figure 1. 
Microsoft 
Security 
Essen-
tials 2.0 
broadens 
its pro-
tections 
with the 
addition 
of behav-
ior-based 
heuristic 
malware 
detection 
and net-
work-
traffic 
filtering. 
 

Another major change, also shown in Figure 1, is network inspection, which 
monitors network traffic, looking for suspicious activity and network-based attacks. 
It works by hooking into the Windows Filtering Platform (WFP) that's part of Win7 
and Vista. (You can read more about Windows Filtering Platform at an MSDN 
site.) 
 
XP lacks the built-in WFP services, so unfortunately, MSE 2.0's network inspection 
is not available on that OS. 
 
These two new features alone make MSE 2.0 a worthwhile upgrade, but 2.0 also 
offers some additional, less significant improvements. 
 
Better integration with Windows components  
 
On all versions of Windows, including XP, MSE 2.0 integrates better with the oper-
ating system and other security components. For example, the new software 
checks to ensure that a firewall is present and active; it offers to turn on and con-
figure the Windows firewall if no other firewall is found. 

(Continued on page 17) 
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Also, you can now limit how much CPU time MSE consumes during a scheduled 
scan. The default is a maximum of 50% CPU utilization. But you can set it as low 
as 10% (should you want the scan to have minimal impact on other tasks) or as 
high as 100% (if you want the scan to complete as quickly as possible). (See Fig-
ure 2.) 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2. MSE 2.0 lets you control how much CPU time the software can con-
sume during scheduled scans. 
 
Using the Advanced settings, you now can force the quarantine folder to empty 
itself after a set amount of time, from days to months (as shown in Figure 3). 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3. If you wish, you can set the quarantine folder to clean itself out pe-
riodically. 
 
You'll notice in Figure 4 that MSE 2.0's new visual design (top) has not strayed far 
from the original (bottom). This freshening is mostly decorative — and that's good, 
because MSE remains extremely easy to use; there's nearly nothing new to learn. 
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Figure 4. MSE 2.0's interface (top) looks a bit more graphically sophisticated 

than 1.0's (bottom) but retains the original's functional simplicity. 
 
Multiple paths to installing MSE 2.0  
 
In the past, Microsoft has used both MSE's built-in update mechanism and Win-
dows Update to roll out updates (see Microsoft Knowledge Base article 975959), 
and it's a safe bet that this upgrade will use the same mechanisms. But as of this 
writing, none of my PCs had been offered version 2.0 — neither automatically nor 
by any other means. 
 
Wait for MSE 2.0 to be offered if you wish, but I recommend grabbing it right away. 
It's available either from the MSE home site or Microsoft's MS Download Center. 
It's the same software in either case. 
 
MSE 2.0 will run on 32- and 64-bit versions of Vista or Win7 and on 32-bit XP. It's 
the same MSE 2.0 setup whether you're installing it new or upgrading from MSE 
version 1.0. 
 
A nice touch: If you're already running MSE 1.0, you don't have to uninstall it first. 
Just download and run the 2.0 setup — it will handle the uninstallation of the ear-
lier version for you. 
 
Another nice touch: The 1.0 uninstall is complete. Everything, including version 
1.0's original /Program Files/Microsoft Security Essentials folder, is deleted. In 
its place, MSE 2.0 installs a wholly new folder called /Program Files/Microsoft 
Security Client. 
 
If you're running any antivirus tool other than MSE 1.0, you should uninstall it be-
fore installing MSE 2.0. (This is standard procedure; in general, you should never 
have two security tools trying to do the same job at the same time.) 
 
The safest way to handle the transition between security tools is to download the 
MSE 2.0 setup file and then disconnect your PC from the network. You can do this 
by turning off or disabling the connection in software or by physically unplugging 
the network cable. 
 
Exit all nonessential software; ideally, you want nothing but the operating system 
and your current antivirus tool to be active. Then, with your PC safely isolated from 
the network, uninstall your old antivirus tool. Reboot when you're done. 

(Continued on page 19) 
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After the reboot, start the MSE 2.0 setup program and let it run to completion. 
When it's up and running, you then can reconnect to the network and resume us-
ing your PC normally. 
 
Once installed, MSE 2.0 immediately updates itself with the latest definitions and 
offers to do an initial scan of your PC. Let it do its thing; once it's set up, MSE is 
one of the least obtrusive security tools you can use. 
 
MSE 1.0 was a winner, but I personally think Version 2 is the best free AV tool, 
period. Highly recommended! 
 
The best way to manage multiple app updates  
 
Secunia's free-for-personal-use Secunia Personal Software Inspector (PSI) Ver-
sion 1 was already in my must-have security software collection. Version 2 is 
even better, with a new look (see Figure 5) and enhanced updating tools. 
 
Like the original, PSI 2.0 scans your installed software and builds a database of 
application version numbers. It then compares what it found on your system to 
Secunia's central database of latest-available version numbers. (The central data-
base contains version information on a huge range of software.) 

 
 

Figure 5. Secunia Personal Software Inspector 2.0 sports an entirely new 
look and feel. But more important, it now can completely automate the proc-
ess of keeping almost all your software up-to-date. 
 
When PSI detects that you're running an out-of-date version, it alerts you: it tells 
you the risk of using the older version and gives you a ready-made link to 
download the latest software patch, upgrade, or update from the software's pub-
lisher (as shown in Figure 6). 
 
  

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 6. PSI 2.0 gives you a detailed assessment of whether your software 
is current. 
 
But PSI version 2 adds a new wrinkle: If you allow it (see Figure 7), PSI automati-
cally downloads and installs the latest versions of your apps for you — fully auto-
matically or by first giving you a chance to review what's going to be updated. 

(Continued on page 20) 
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Figure 7. Secunia Personal Software Inspector (PSI) 2.0 automatic-update 
option. 
 
I heartily recommend PSI 2.0 because it eliminates the need to have lots of small, 
separate, auto-update programs running — you know, the Apple updater, the 
Adobe updater, the Java updater, and so on. Instead, this one tool makes keeping 
your key software up-to-date a nearly effortless task. 
 
You'll find the download link for PSI 2.0 on its info page. Installation is easy; just 
follow the prompts. If you have the original PSI version installed, the 2.0's setup 
will automatically uninstall it for you. 
 
Start the new year right, and get all your software updated today  

WORLD SURVEY BY PHONE  
Last month a world-wide survey was conducted by the UN. 
 
The only question asked was: 
 
"Could you please give your honest opinion about solu-
tions to the food Shortage in the rest of the world?" 
 
The survey was a massive failure because of the follow-
ing: 
 
1.  In Eastern Europe they didn't know what "honest" 
meant. 
 
2.  In Western Europe they didn't know what "shortage" 
meant. 
 
3.  In Africa they didn't know what "food" meant. 
 
4.  In China they didn't know what "opinion" meant. 
 
5.  In the Middle East they didn't know what "solution" 
meant. 
 
6.  In Israel they didn't know what "please" meant. 
 
7.  In the USA they didn't know what "the rest of the 
world" meant. 
 
8.  In the UK, Canada and Australia they hung up as soon 
as they heard the Indian accent. 
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AU T OM AT IC A L LY  SE LE C T I N G  
WO R D S  
When you are editing your document, there are many times that Word tries to 
guess what you are doing and then complete your task for you. This helpfulness 
can be aggravating at times. One such instance is when you are trying to use the 
mouse to select text from the middle of one word to the middle of another. When-
ever you click inside a word and then start dragging the mouse, Word assumes you 
want to make a selection. As soon as you move the mouse pointer outside the 
word, the program assumes you wanted to select the entire first word in which you 
originally clicked. 

If you want to ensure that Word doesn’t make that assumption, you need to follow 
these steps to turn off the offending feature in Word 97 through Word 2003: 

1. Choose Options from the Tools menu. Word displays the Options dia-
log box. 

2. Make sure the Edit tab is selected. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Edit tab of the Options dialog box. 

3. Make sure the When Selecting, Automatically Select Entire Word check 
box is cleared. 

4. Click on OK. 

5. You can follow these steps if you are using Word 2007 or Word 2010: 
1. Display the Word Options dialog box. (In Word 2007 click the 
Office button, then choose Word Options. In Word 2010 display the File tab 
of the ribbon, then click Options.) 

2. Click Advanced at the left side of the screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Advanced area of the Word Options dialog box. 

3. In the Editing Options area, make sure the When Selecting, Automati-
cally Select Entire Word check box is cleared. 

4. Click on OK. 

Copyright © 2011 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands of 
free Microsoft Word tips can be found online at http://word.tips.net. 
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CA L C UL AT IN G  WE E K -EN D I N G  
DAT E S  
Do you keep track of information based on week-ending dates? 
Many businesses do, and therefore need a quick way to calculate 
the week-ending dates for the complete year. The dates could be 
easily calculated with a macro, but you can do it just as easily 
with formulas. 

There are two formulas you can use in order to calculate your 
week-ending dates. Let’s assume, for the sake of this example, 
that your year is stored in cell A1. You could then figure out the 
first Saturday of the year by using this formula in cell A3: 

This works because the WEEKDAY function returns a value of 1 
(Sunday) through 7 (Saturday) for any date. If you subtract that 
value from 7, then you have a value of 6 (Sunday) through 0 
(Saturday). When you add that value to the DATE value for 
January 1 of the year, you end up with the first Saturday of the 
year. 

If you prefer to have your weeks end on Fridays, then the for-
mula needs to change a bit: 

Finally, if you prefer to have your weeks end on Sundays, then 
the formula needs to be like this one: 

=DATE(A1,1,1)+7-WEEKDAY(DATE(A1,1,1)) 

=DATE(A1,1,1)+7-(WEEKDAY(DATE(A1,1,1)+1)) 

This formula uses a parameter for the WEEKDAY function that 
calculates weekdays that range from 1 (Monday) through 7 
(Sunday). 

Once you have the first week-ending date for the year (in A3, re-
member?), then you can calculate the rest of the week-ending 
dates for the year. Place the following formula in cell A4: 

This checks to see if one week past the previous date is still in 
the year. If it is, then the new date is returned. If it isn’t, then an 
empty string is returned. If you copy this formula from A4 down 
through A55, then you will have all the desired week-ending 
dates for the year. With the formulas in place, simply change the 
year in cell A1 to see how the dates change. 

The range A3:A55 provides room for 53 week-ending dates, 
which is possible for any given year. Because you used the IF 
statement in the formula in cells A4:A55, then the very last value 
(A55) will be blank if there were only 52 week-ending dates for 
the year. 

Copyright © 2011 by Sharon Parq Associates, Inc. Re-
printed by permission. Thousands of free Microsoft Excel 
tips can be found online at http://excel.tips.net. 
 

=DATE(A1,1,1)+7-WEEKDAY(DATE(A1,1,1),2) 

=IF(YEAR(A3+7)=$A$1,A3+7,"") 
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Daddy's Poem 
Her hair was up in a pony tail, Her favourite dress tied with a 

bow. 
Today was Daddy's Day at school, And she couldn't wait to go. 

 
But her mommy tried to tell her, That she probably should stay 

home. 
Why the kids might not understand, If she went to school 

alone. 
 

But she was not afraid; She knew just what to say. 
What to tell her classmates Of why he wasn't there today. 

 
But still her mother worried, For her to face this day alone. 

And that was why once again, She tried to keep her daughter 
home. 

 
But the little girl went to school Eager to tell them all. 
About a dad she never sees A dad who never calls. 

There were daddies along the wall in back, For everyone to 
meet. 

Children squirming impatiently, Anxious in their seats One by 
one the teacher called A student from the class. 

To introduce their daddy, As seconds slowly passed. 
 

At last the teacher called her name, Every child turned to 
stare. 

Each of them was searching, A man who wasn't there. 
 

'Where's her daddy at?' She heard a boy call out. 
'She probably doesn't have one,' Another student dared to 

shout. 
 

And from somewhere near the back, She heard a daddy say, 
'Looks like another deadbeat dad, Too busy to waste his day.' 
The words did not offend her, As she smiled up at her Mom. 

And looked back at her teacher, Who told her to go on. 
 

And with hands behind her back, Slowly she began to speak. 
And out from the mouth of a child, Came words incredibly 

unique. 
 

'My Daddy couldn't be here, Because he lives so far away. 
But I know he wishes he could be, Since this is such a special 

day. 
 

And though you cannot meet him, I wanted you to know. 
All about my daddy, And how much he loves me so. 

 

(Continued on page 24) 
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He loved to tell me stories He taught me to ride my bike. 
He surprised me with pink roses, And taught me to fly a kite. 

 
We used to share fudge sundaes, And ice cream in a cone. 

And though you cannot see him. 
I'm not standing here alone. 

 
'Cause my daddy's always with me, Even though we are apart 
I know because he told me, He'll forever be in my heart' With 

that, her little hand reached up, And lay across her chest. 
Feeling her own heartbeat, Beneath her favourite dress. 

And from somewhere here in the crowd of dads, Her mother 
stood in tears. 

Proudly watching her daughter, Who was wise beyond her 
years. 

 
For she stood up for the love Of a man not in her life. 
Doing what was best for her, Doing what was right. 

 
And when she dropped her hand back down, Staring straight 

into the crowd. 
She finished with a voice so soft, But its message clear and 

loud. 
 

'I love my daddy very much, he's my shining star. 

And if he could, he'd be here, But heaven's just too far. 
 

You see he is an Aussie soldier And died just this past year 
When a roadside bomb hit his convoy And taught Australians 

to fear. 
 

But sometimes when I close my eyes, it's like he never went 
away.' And then she closed her eyes, And saw him there that 

day. 
 

And to her mothers amazement, She witnessed with surprise. 
A room full of daddies and children, All starting to close their 

eyes. 
 

Who knows what they saw before them, Who knows what they 
felt inside. 

Perhaps for merely a second, They saw him at her side. 
 

'I know you're with me Daddy,' To the silence she called out. 
And what happened next made believers, Of those once filled 

with doubt. 
 

Not one in that room could explain it, For each of their eyes 
had been closed. 

But there on the desk beside her, Was a fragrant long-
(Continued on page 25) 
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stemmed rose. 
 

And a child was blessed, if only for a moment, By the love of 
her shining star. 

And given the gift of believing, That heaven is never too far. 
 

Send this to the people you'll never forget and Remember to 
send it also to the person that sent It to you. 

It's a short message to let them know that you'll never forget 
them. 

If you don't send it to anyone, it means you're in a hurry and 
that you've forgotten your friends. 

Take the time...to live and love. 
Until eternity.  God bless!   

 

The Trial 
In a criminal justice system based on 12 individuals 
not smart enough to get out of jury duty, here is a 
jury to be proud of.   
A defendant was on trial for murder.  There was strong 
evidence indicating guilt, but there was no corpse.   
In the defence's closing statement, the lawyer, knowing 
that his client would probably be convicted, resorted 
to a trick.  
 "Ladies and gentlemen of the jury, I have a surprise 
for you all," the lawyer said as he looked at his 
watch.   
"Within one minute, the person presumed dead in this 
case will walk into this courtroom." He looked toward 
the courtroom door.   
The jurors, somewhat stunned, all looked on eagerly.  A 
minute passed.  Nothing happened. 
Finally the lawyer said, "Actually, I made up the 
previous statement.   
But you all looked on with anticipation.   
I, therefore, put it to you that you have a reasonable 
doubt in this case as to whether anyone was killed, and 
I insist that you return a verdict of not guilty."  
The jury retired to deliberate.  A few minutes later, 
the jury returned and pronounced a verdict of guilty.   
"But how?" inquired the lawyer.  "You must have had 
some doubt; I saw all of you stare at the door."  
(WHAT DO YOU THINK THE ANSWER WAS?) 
 
 
 
The jury foreman replied: "Yes, we did look, but your 
client didn't." 
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